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1. Overview

Objects are securable and customizable within your workspace. Each
Relativity workspace already contains system objects such as Document,
OCR objects.

The Document object allows you to create fields which store objective
or subjective information about the document.

You can create other objects outside of the document object to store
data and link to other objects. Without Objects, a document might have
a custodian field that stores the name of the custodian.

/ Document
Control Number
Sent Date
Email Author
Email Recipient
Custodian

N\ J

Document Properties

But what if you want to store information about the Custodian? Using
Relativity Objects, you can create a Custodian object. This object can
then store information about the custodian — their name, their role,
their start date, etc.

Custodian
Custodian Name
Company
Start Date
End Date
Involvement
Role

Custodian Properties

You can then connect that Custodian object to the Document object.
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Workspace \ ( Document \

Workspace Name Control Number
Fields Sent Date
Choices Email Author
Views Email Recipient
Layouts | Custodian
Documents —
Custodian /— = N /
Custodian
] Custodian Name

Company

Start Date

End Date

Involvement

Role

Workspace —Custodian—Document Connection

This guide provides you with comprehensive instructions, allowing you
to create and utilize the following Objects.

=  Custodians
= Questions

2. Creating a Custodian Object

While custodians exist within every document, the current custodian
field only houses the name of each individual. Custodian Objects
represent structured data related to the individuals themselves, housing
anything from their contact information, length of employment, etc.

2.1 Scenario

Your firm is representing a company in the middle of a lawsuit. The
review process is going to be centered around specific custodians who
meet certain criteria. In order for your review team to conduct an
effective document audit, they must have detailed background
information related to workspace custodians; specifically, each
custodians’ role within the company, as well as their hire date.

2.2 Creating a Custodian Object

First create a new Custodian custom object to house the required
information. This new document object creates a field to take the place
of your original document object “Custodian” field.

-> Exercise: Creating a Custodian Object

1. Select the Object Type tab.
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2. Click the New Object button.

i 4

Rl AlObject Types = B

0 Selected Eteml.‘s]‘\

Administration::Object Type -

N r—
H [] Edit Group Yes 4/27/2011 10:31 AW CDT Linder
¥l ] Edit  View Yes 4/77/2011 10:31 AW CDT Linder
E [] Edit Code Yes 4/27/2011 10:31 AW CDT Linder
New Object Type

3. Inthe Name <type: Custodian>.
4. Inthe Parent Object Type, select Workspace.

The Custodian and Document objects are under the Workspace
object. If you make Custodian a child of the Document object you
won’t have the ability to link with multiple documents.

I
1 1

I
|

Correct Incorrect

Object Parent Diagram

5. Inthe Enable Snapshot Auditing On Delete drop down, select
Yes.

6. Inthe Pivot drop-down, select Enabled.

7. Inthe Copy Instance On Workspace Creation drop-down, select
Yes.

If it is set to Yes when deleting items from the object, Relativity
captures a snapshot of the item’s current field values. This
increases the size of the delete audit for the record, but may
be useful when querying the workspace history.

If this is set to No when deleting items from the object,
Relativity deletes the item without capturing its field values.
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Administration::Object Type w q) Hi, Mary Ann

Save and Back

Object Type Form
8. Click Save and Back.
9. The Object Type named Custodian appears in the Object list.

57 4 [ pocuments _ Review Batshes | Acninstration:Object Type v

Ml Custom Objects + [t Cg

Analytics Categorization Result

Analytics Categorization Set

Analytics Cat

Analytics Example

Analytics Profile

Custodian *_ -

Object List
2.3 Editing Items to Include Objects
When a new object is created the system automatically creates an

associated field layout and view. Let’s now examine these fields,
layouts and views.
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1. Select the Fields tab and click the Edit View button.

57 4 (Coocuments . Reviewtetes | Admstration:fiis »

Mew Fietd

Al Non-System Document Fields —5@ =

0 Selected Item(s)

. . Document Alert Long Text
Document E‘? Edit  Analytics 1-1sMain Yes/ Mo
Document ﬁh Edit  Analytics 1-Score Decimal
Document E‘Fh Edit  Analytics 1-SimilarDocs Fixed-Length Text
E Document E‘Fh Edit  Author Fixed-Length Text

Edit View

The Basic Information form opens on Step 1.

2. Leave Name as All Fields to view all system fields that pertain to

the Custodian Object.

{Owner: Public

ML

(57 4 (CBocuments ReviewBatehes| scminstraton:iews ~ < summary Repots _searchinde P . 1ari 2

Fields (Step 2 of 4)

B e ] e |

Name: 4y Fieds
Order: 1

Available In Object Tab: ves -

Set Fields

Available Fields Selected Fields
Alow Group By - Object Type *—
Alow HTML Security
AMlow Fivot Edit
Hlow Sort/Taly Mame
Artifact ID Is Required
Asspciative Object Type Is Identifier
Available In Field Tree Include in Text Index
Available In Viewer “ Filter Type
Created By Bl | Fiec Type '
Field Tree View _ Created On
Formatting Length .
Friendly Hame “
Highlight Sets
Import Behavior
Is Artifact Base Field
Keyboard Shortcut
Last Modified By
Last Modified On
inked S
. L —T— r

Basic Information
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3. Select Object Type from Available Fields and move it to Selected
Fields using the single blue arrow in the center. If you wish to
adjust its position left to right in the view use the Up arrow on
the right-hand side. Higher on list is farther left in the view.

4. Click Save.

5. Click on the Show Filters links. In the Object Type you are now
able to filter and view on “Custodian”.

After editing your field view, you must do the same for your layout
view.

6. Select the Layouts tab and click the Edit View button.

Y
@ 4" Mm\& wtches\( Administration::Layouts w
Hew Layout BECTRET S l_:|=_,_|'l Iﬂ
0 Selected Itemi(s) Reset Column Sizes | Show Filters |
"]
[ Edit |j Default Relativity Application Layvout Relativity
[ Edit |j Analytics Categorization Result Layvout  Analytics
[ Edit |j Analytics Category Layvout Analytics

Edit View

7. Leave Name as All Layouts to view all system layouts that
pertain to the Custodian object.
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Administration::Views w de I Hi, Mary Ann

Owner: Public - 8 Feis stepzora -

Name: | ayouts

Order:

View Order

Available In Object Tab: ves

Set Fields

Available Fields Selected Fields

Artifact 1D
Created By Mame

Keywords Order In Dropdown

Last Modified By Created On

Notes Last Modified On

Overwrite Protection Object Type *—

COrwiner

Relativity Applications “ .
Security N

LI P b L) F—T—| b

Basic Information

8. Select Object Type from list of fields on the left Available Fields
column and move right to Selected Fields using the single blue
arrow in the center. Adjust its position using the Up arrows on
the right-hand side.

9. Click Save.

10. Click on the Show Filters link. In the Object Type, you are now
able to filter and view on Custodian.

2.4 Creating Custodian Fields

Now that the Custodian Object has been created, its corresponding
fields to hold detailed custodian information must be created. As
required, custodians’ roles and hire dates will be added.

1. Select the Fields tab. If you have custodian information already
in your database follow the steps below. If not then you can
skip ahead to step 9 below.
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We will edit the document object “Custodian” field. This is going to
be exported and not used any longer for the custodian information
so we will rename it to “CustodianOld”. Don’t delete it as we will
export the current custodian data.

2. Find Custodian field from list and click Edit.

3. Inthe name field rename “Custodian” to “CustodianOld”
4. Click Save and Back.

5. Click Show Filters, filter on the Object type Custodian.

Notice the various fields automatically created when creating an
object. The Name field is our new custodian field. We will
create other custodian-related fields. The custodian object
creates a field to hold custodian data but this is not yet
connected to the document object. Since it is not connected to
the document object you will not be able to see this on the
documents view or import data to this field from the Desktop
client. We will rename it to custodian to hold the name
information.

6. Click Edit next to the Name field.
7. Inthe Name field change Name to Custodian.
8. Click Save and Back.

9. Click New Field.

=
£ Review Batches | Administration::Fields w

Al Figlds - Bz (&

0 Selected Itemis) Reset Column Sizes | Show Filters
OCR Profile E° Edit  Accuracy fes
Search Terms Report [|° Edit Add Terms Ho
Document Edit  Alert Mo

New Field button
10. Create a fields related to Custodian roles as follows:

= QObject Type: Custodian
= Name: Company
=  Field Type: Fixed-Length Text
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11.

12.

13.

14.

= |ength: 255

=  Required: Yes

= |nclude in Text Index: No
= Linked: No

= Filter Type: Textbox

=  QOpen to Associations: Yes

Click Save and New.
Create another field related to custodian Start Date as follows:

=  Object Type: Custodian
= Name: Start Date

= Field Type: Date

=  Required: Yes

= Formatting: Date

= |nclude in Text Index: No
= Linked: No

= Filter Type: Textbox

Click Save. Your custodian-related fields are created.
Create a field related to custodian roles as follows:

= “Object Type” drop-down: Document

Creating this object connects the Custodian object to the
Document Object. This is the only item with an Object type of
Document. Custodian information can be added here or in the
Custodian object named custodian renamed from name and
created when the custodian object was created. In the field type
for this example we will use the object field. This allows for a
one to many connection to the documents. One custodian to
many documents. You cannot attach multiple custodians to one
document using this field type.
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( Workspace

Document

Workspace Name

Fields

Choices

Views

Layouts

Documents —

Custodian ==y

\ / ( Custodian
| Custodian Name

Company
Start Date
End Date
Involvement
Role

Workspace—Custodian—Document Connection

= Name: Custodian

= Field Type: Single Object
= Object Type: Custodian
= Required: Yes

= Include in Text Index: No
= Linked: Yes

15. Click Save and New.

Control Number
Sent Date

Email Author
Email Recipient
Custodian

Field Information

Name: | cystogian
Field TYP&!  single Object - Object - an . Available In Viewer:
Type:
Length: : Available In Field Tree: pg  +
) ho - Field Tree View: : BER
Include in Text Index: How HTML
Unicode: Formatting: ane +
Icentifier: Open to Assaciations
Relativity Appiications: B

Custodian Object Field

2.4.1 Applying Custodian-Related Fields to a Layout

After creating custodian-related fields, you must apply them to your

Custodians layout.
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1. Select the Layouts tab and filter Object Type to Custodian

2. Click the Custodian Layout hyperlink. This layout was
automatically created with your Custodian Object.

]ﬂl 'ﬂl’ Doc:umnts\g Hev'lewBatchesT Administration::Layouts »
Aovous + C3E3

0 Selected Item(s)

Il
(Al = (Al (Al (ML)
[[] Edit Custodian Layout 0

Custodian Layout hyperlink
3. Click on Build Layout to begin.

4. Click on Default Category and customize the Title field to
Custodian Information.

5. Click Save.

6. The “Custodian” field which was originally named “Name” is
added to the layout by default. Click the Add Field button.

Building Layout: Custodian Layout
| |

(0:0) Default Category |Add Field

{R:1] O:1 | Read Only: No)

Remove

Default Category and Add Field button
7. Add the role field as follows:
=  (Category: Custodian Information
* Field: Company
= Read-Only: No
=  Order: 20
= Column: Both Columns

= Row:1
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= Display Type: Text

8. Click Save and New.

9. Add the hire date field as follows:
= Category: Custodian Information
= Fields: Start Date

= Read-Only: No

Order: 30
=  Column: Both Columns

=  Display Type: Date
Add Field to Layout

Category: Cystodian Information + Display TYpe: pate ~

Figld: ctart Date - Show Name Column:

Repeat Columns (Check Box

Read Only:
e Mo v and Radic Button):

Order: 3q Rows (Long Text Only):
Column: | ERTY T ~ Custom Label: B Cir
Row: 4

Add Field to Layout dialog box
10. Click Save.

When you create a new object field you also get the option of
adding the Associative Object list in your layout. This allows you
to connect to another object. Since we are in the Custodian
Object layout adding the Associative Object adds the Document
object list.

11. Click on Add Associative Object List.
= Associative Object: Document- Custodian
= View: Documents
= Links Point to Popup: No

=  QOrder:10
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I | By selecting “Yes” in the “Links Point to Pop-up” drop-down,
T Relativity will open a dialog box beside the document view.
- By selecting “No”, Relativity will navigate away from the

I — document and redirect the reviewer to another page.

12. Click Save. We are done with the custodian layout.
13. Click Close.

Exercise completed

If you are using a workspace with custodian data already present follow
the steps below to move that data to the new custodian field. If not,
skip ahead to Section 4.2 to manually enter custodian information.

In order to use the new custodian object we need to populate the
custodian information. When using an existing workspace, any existing
custodian data must be exported out of the current document object
custodian field. Then the exported data is loaded into the new
custodian field in the document object. This field will replace the
standard “CustodianOld” field.

3.1 Preliminary Steps
There are two scenarios that affect the way Custodian data is loaded:

= Data has already been loaded into your workspace (See Section
3.2)
= Data has not been loaded into your workspace (See Section 4.2)

Regardless of whether data has been loaded into your
. | workspace, manual custodian entry is always available. See
| | Section 4.2 for more details.

3.2 Exporting Custodian Data

If you are working on an existing workspace with existing Custodian
information, you will want to transfer that information from its existing
field to your object field. This is accomplished by exporting the old
data and importing into the new field.

- Exercise: Exporting Custodian Data

1. Setthe Custodian field to occur in your document view:
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= |nthe document tab, click Edit View ( Efr) next to the

dropdown.

= Click Next on the Enter Basic Information screen.

=  With the arrows, shift CustodianOld from the Available

Fields to th

e Selected Fields box on the right.

=  (Click Done. Note that the custodian name now occurs in the
document view.

Available Fields

Selected Fields

Analytics 1-1sMain
Analytics 1-5core
Analytics 1-SimilarDocs
Author Domain
Batch::Assigned To
Batch::Batch 5et
Batch::5tatus
Beginning Bates
Categorization
Cluster Maggi, Mike
Custodian

Deposition Kit
Extracted Text
Markup 5et - Attorney
Markup Set - Primary
Matter 001 Production
MD5 Hash

Multiple Choice Examples
MR Residfs

4. I

»

iControl Mumber
CustodianOld

m

4 4| 1 3

Select Fields Display

2. In Mass Operation bar select All ### then Export to File. Export
all your custodian and control number data to an external file.

Click Go.

While you can export all your fields in view and only load the

custodian field
number and cu

the export will go faster with only the Control
stodian fields in view.

Exporting 12003 Documents

1

Format:

Encoding:

Concordance DAT format (.dat) -

Western European (Windows) -

Export to File
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https://training01.kcura.com/Relativity/Admin/View/Edit.aspx?AppID=1017954&ArtifactID=1003684

3. The Export dialog box appears. Set the Format drop-down to
Concordance DAT format (.dat), and the Encoding drop-down
to Western European (Windows).

4. Click Run. Save the .dat file to your local machine. In Section
4.1.1, this information will be re-imported.

Exercise completed

Once the new Custodian field has been created, corresponding data
must be applied. As covered in Section 3.1, there are two scenarios that
affect the way custodian data is loaded:

= Data has already been loaded into your workspace
= Data has not been loaded into your workspace

4.1 Importing Load Files

Refer to Section 4.1.1 if you previously exported custodian information
to a .dat file. Continue to Section 4.1.2 if you have not exported data
previously loaded data in your workspace.

4.1.1 Importing Custodian Data

If data is present in your workspace, the previously saved .dat file
containing your custodian information will need to be imported.

- Exercise: Importing Custodian Data

1. Open the Relativity Desktop Client and browse to your
workspace.

2. Select Tools | Import | Document Load File.

3. Inthe Load File tab, browse to and select the .dat file. Control
Number and Custodian appear in the File Column Headers box.
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Relativity Desktop Client | Import Document Load File lEI_IéJ
File Import
Import Destination
“Salt vs. Pepper’
Load File | Field Map }
Load File
|C:"-.leers"-ngus‘ton'-.DD',':n\oads'-s.‘tport {1).dat |
' First line contains column names Aotz
: = Control Number (1}
Start Line 0 = |||Cardn0a e
File Encoding
Westem European (Winde ~| ... | 7
Characters
Column
[1(ascii-020y |
Quote
|b (asCi1-254) |
Newline
|& (asci74) -
Multi-Value
|: (asci-059) JEd|
Nested Value
[ iascilos2) JEd|
Load File tab

4. Inthe Field Map tab, select Custodian and Control Number
from the Workspace Fields and CustodianOld and Control
Number from the Load File Fields. Map in the center, adjust
their positions by using the Up arrow buttons.

5. Inthe Overwrite dropdown, select Overlay Only.
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Relativity Desktop Client | Import Document Load File

File Import
Import Destination
“Salt vs. Peppert.
Load File  Field Map
‘Workspace Fields

Load File Fields

Categorization "
Cluster :: All Docs
Cluster :: All Docs :: Sco
Cluster :: Czlifornia
Cluster :: California :: Sc
Cluster :: Cluster - SF T—
Cluster :: Cluster—-SF T
Cluster :: Maggi, Mike
Cluster :: Maggi, Mike =
Confidentizlity
Conversationlndex

CSR - Primary Language
Custodian Tracker
Custodians

Deponent

Deposition Kit
Depostion Date
Duplicate

Fmail Rachs

2
<
[=]

Control Number [Identifier]
‘Custodian

Control Mumber (1)
CustedianOld (2)

oE

< (1 |

—Overwrite

[~ Folder Info

Bverayony | K

Crwerlay |dentifier

Native File Behavior

|C|:|rrtru| Mumber [Identifier]

=

[” Load Native Files

=
Repository

Native file paths contained in column:

|

Bl |- ¥

Extracted Text
-

Encoding for undetectable files

= —

_——

Field Map tab

6. Select Import | Import File.

7. You can close out of the desktop client when this has

completed.

[Import]

Preview File...

Preview Errors...

Import File...

Preview Choices And Folders...

[

v | Force folder preview

Import File

Exercise completed

4.2 Manual Custodian Entry

Regardless of whether data has been loaded into your workspace,
manual custodian entry is always available. This exercise will guide you
through adding a custodian manually and assigning them to documents.
We need to add a layout to the document object with our custodian
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information. The previous layout we edited was for the custodian
object.

1. Select the Layouts tab and click the New Layout button.
2. Create a layout using the following:

=  Object Type: Document

=  Name: Custodian Info

=  QOrder: 80

| o oo | emnssssio e Sy i s |

|Owner: Public -
Layout Information
Object TYPE: Document A

Name: ¢ ystodian Info

Order: 20 View Order

Overwrite Protection:

Relativity Applications: B

Keywords:

Hotes:

Layout Information

3. Click Save. Click the Add Field button.

Building Layout: Custodian Info

(0:0) Default Category |Add Field|[Add Tex New Category
(R:1] O:1 | Read Only: Yes) Enable Copy from Previous

Disable Gopy from Previons

ArgGhTd O ECEINSE:

Add Associative Object List

Add Field button

4. The Add Field to Layout Dialog box opens. Complete as follows:
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=  Field: Custodian
= Read-Only: No
= Leave other fields as default

5. Click Save. The field appears in the layout.

Building Layout: Custodian Info

(0:0) Default Category Add Tex
{R:1 | 0:1 | Read Only: Yes)

(R:1 | 0:20 | Read Only: Ho)

Add Associative Object List

Custodian field

4.3 Adding Custodian Information

1. Select the Custodian tab.

Hi, Greg

b

Custodian Tab

2. Click the New Custodian button.

3. Fill'in the information for a new custodian including custodian
name, role and hire date. If you have imported the old
custodian information, click on the Edit link to complete the
new custodian object fields.

Revie

EUEETa G EL N All Custodian

0 Selected Itemi(s)

New Custodian manual entry
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4. Click Save.

If you have manually added custodians to your workspace, you must
associate them with their corresponding documents.

4.3.1 Associating Custodians and Documents

Once you have created your custodian-associated layout, you can
manually associate custodians with specific documents. The imported
custodian information already has custodians associated to documents.

1. Select the Documents tab and select the checkboxes of a few
documents in the list.

2. Inthe Mass Operations bar, select Checked and Edit.

H Documents ~ In This Folder & Subfolders - - Search... v 4 Li
3 Selected Item(s) Save as Search | Reset Column Sizes | Show Filters | Clear Al | [tems W 225 (of 1,000) H4Ppr M
R
AMEYERS 0001149 AMEYERS 1/31/2002 12:59 PM RE: Profile Error Again
Edit AMEYERS_0001150 AMEYERS 2/4/2002 11:47 PM Online Trading Simulation
Edit AMEYERS_ 0001151 AMEYERS 2/5/2002 1:06 PM Expense Reports
Edit AMEYERS_0001152 Badeer, Robert 2/5/200Z 4:17 PM Trading Assistant
Interviews
Edit AMEYERS 0001153 Badeer, Robert 2/5/2002 6:00 PM UBSW Orientation - Friday, 3
2/8/02
Edit AMEYERS_0001154 Badeer, Robert
Edit AMEYERS 0001155 AMEYERS
Edit AMEYERS_0001156 AMEYERS
Edit AMEYERS_0001157 AMEYERS L3
Edit AMEYERS 0001158 AMEYERS 2/5/2002 8:40 PM Quick Tips for the UBSWE
migration
Edit AMEYERS 0001159 AMEYERS 2/6/2002 11:23 AM PLEASE READ=»>>1IBS

MIGRATION »=»= YO HAVE
48 HOURS - Message from

Louise Kitchen
& Edit  AMEYERS 0001160 AMEYERS
ﬂaﬁ [ Edit AMEYERS 0001161 AMEYERS 2/6/2002 12:29 PM »>=>READ! UBS EMAIL
MIGRATION<==<
214 @ [ Edit AMEYERS 0001162 AMEYERS 2/6/2002 3:15 PM Confirmation of Interview
on Friday with Tim Belden
— - S
Checked - Edit - Viewing the First 1,000 + of 12,003 items in sets of 25 ¥ per page

Mass Edit

3. Click Go. The Mass Operations dialog box appears.

4. Select Custodian Info layout in the drop-down and select the
Custodian Object checkbox. Click the ellipsis (...) button.
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Edit 3 Documents

Custodian Info -
Default Category

Control Number:

[ Custodian: B

Mass Operation dialog box

5. The Select an Item dialog box appears. Select the radio button
next to a custodian’s name.

Select Item - Custodian

1 Selected Item(s) Reset Column Sizes | Show Filters | Clear AL | Items 1 -11(of11) M 4 P M

||
ol
£

(@] Allen, Paul

@) AMEYERS

() ARING

() SSHACKLET

(@] Sieja, Andrew
(@] Arnold, Johnny
() Arora, Harry
(@] Badeer, Robert
.:::. Bailey, Susan

() Bass, Eric

HEREHNNNFMNNNN

c

L5 Viewing the first 11 of 11 items in sets of 5 ¥ per pags|

B

Select an Item dialog box

6. Click OK and then Save. The custodian has been applied to the
selected documents. To view the custodian’s information within
the document view, open a document associated with your
custodian.

7. Inthe coding drop-down, select the Custodian layout. The
hyperlinked custodian appears in the view.

8. Click the hyperlinked custodian. The editable information and
documents associated to this custodian appear in the view.
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4.4 Editing Custodian Information

Within the Custodians tab, values for the “Company” and “Start Date”
fields may be coded.

1. Select the Custodian tab and click on the Edit hyperlink next to
a custodian.

Allen, Paul

AMEYERS
ARING

SSHACKLET

Sieja, Andrew
Arnold, Johnny
Arora, Harry
Badeer, Robert

EBailey, Susan

Bass, Eric

Edit custodian

2. Code each custodian’s information in the fields.

i <

Custodian Layout - Save Save and New Save and Back

Custodian Information

Name: wen, paul

Company: gnrgn

Start Date: gy 1998 B

Custodian information
3. Click Save.

4. View your custodian information with all the corresponding
documents below. This is the Custodian Object.

5. After you update the company information go to the
Documents tab and add Custodian::Company to the view.
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Notice edits in the Custodian tab carry over to the document
tab.
Custodian Information

Mame: AMEYERS

Company: Enron
Start Date: 9/21/1999

Document (Custodian)

...- Control Number Custodian

A = AMEYERS_0000008 AMEYERS
B 0 Edit AMEYERS_0000009 AMEYERS
El* CZ Edit AMEYERS_0000011 AMEYERS
Gl 1 Edit  AMEYERS 0000012 AMEYERS

Custodian object information with corresponding documents listed below

Exercise completed
5. Creating a Question Object

Custodians can have multiple documents linked to them but documents
can have only one custodian. This is a one to many relationship — many
documents to one custodian.

A reviewer may have one or many questions about a document, and
each question may be associated with one or many documents —a
many-to-many relationship.

In this exercise we are going to use the scenario of a question and
answer object to build a conversation about a document.

1. Select the Object Type tab.
2. Click the New Object button.
= Name: Question.
=  Parent Object Type: Workspace.

= Enable Snapshot Auditing On Delete: Yes.
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3. Click Save & Back The new Object Type Question appears in the
list.

Salt vs. Pepper
‘Jr Documents REV'[E’WE-&I.GMST Administration::Object Type w Summary Reports

NEVRS Rl Al Custom Objects - E“J F_d

0 Selected Item(s) Reset Column Sizes | Shy

rr
=]

Imaging et

|I'|1
=
=

Hative Type
OCR Profile

rn
=)

m
=
=

OCR Set

Question gf—

Repeated Content Filter

rn
=)

m
=
=

Review

m
=
=

Reviewer

rn
=

Search Terms Report

m
=
=

Search Terms Result

rn
=

Sender Domain

m
=
=

Team

rn
=

Transform

m
=
=

A O i i |

Transform Set

Checked = Copy - Viewing the Fi

Object Type list

Exercise completed

5.1 Editing Views

After creating a Question object type, browse through other tabs in the
system to view and verify the impacted changes. This is accomplished
by editing the views within each tab to see which fields and layouts
pertain to the object type.

-> Exercise: Editing Field and Layout Views

If you completed the Custodian object exercise before you can skip this
step and go to Section 6.0.

1. Select the Fields tab and click the Edit View button.
The Basic Information form opens on Step 1.

2. Leave Name as All Fields to view all system fields that pertain to
the Question object.
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Administration::Views w

mmary Reports earch Indexe [se tu P Hi, Gres
|owner: Public - m Fields {Step 2 of 4) -
Settings
Name: ) questions
Order: 1 View Order
Available In Object Tab: ves
Set Fields
Available Fields Selected Fields
Artifact ID Edit
Security Name
System Created By
System Created On
System Last Modified By
System Last Modified On
R = r R F—— r
4

m

Basic Information

3.

Select Object Type from Available Fields and move it to Selected
Fields using the single blue arrow in the center. Adjust its

position using the

Click Save.

Up arrow on the right-hand side.

Click on the Show Filters links. In the Object Type you are now

able to filter and vi

ew on Question.
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4 Documents . Review Batcms‘f Administration::Fields w ._Summary Re

Al Fields - B B
0 Selected Item(s) Reset Column Sizes | Hide F

8 oviect e ™

Question hd (Al = (Al (Al

[] Question |j"‘ Edit  Artifact ID Ho

[[] Question E° Edit Hame ff— Mo

|:| Question rj“ Edit  System Created By 1]

|:| Question |j"‘ Edit  System Created On Mo

|:| Question |j"‘ Edit  System Last Modified By Mo

|:| Question rj“ Edit  System Last Modified On ]

Question filter

After editing your field view, you must do the same for your layout
view.

6. Select the Layouts tab and click the Edit View button.

7. Leave Name as All Layouts to view all system layouts that
pertain to the Question object.

8. Select Object Type from list of fields on the left Available Fields
column and move right to Selected Fields using the single blue
arrow in the center. Adjust its position using the Up arrows on
the right-hand side.

9. Click Done.

10. Click on the Show Filters link. In the Object Type, you are now
able to filter and view on Question.

Exercise completed

6. Question Object Field Layout Creation

We have an object to store data but we need fields for that object. We
are creating a question and answer field which will hold the
information. The question can be a question about a document and the
answer will be completed later by another reviewer, most likely a higher
level reviewer.
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-> Exercise: Adding Fields to Question object

1. Select the Fields tab.

2. Filter the fields to show the Question Object Type.

3. The Name field was created with the Object.

\JI’ Docmmts\& Rev[ewﬁatches\[ Administration::Fields -

Hew Field ETREE

+ B B

Summary Re

0 Selected Item(s)

| Object Type ¥

Reset Column Sizes | Hide F

Cuestion A (Al o« (Al (AL
[] Question [~ Edit Artifact|D Ho
[[] Question E° Edit Hame ff— Mo
[] Question L~ Edit System Created By Ho
|:| Question E  Edit System Created On Mo
[] Question [~ Edit System Last Modified By Mo
|:| Question ] Edit System Last Modified On Mo
New Field List

4. Click on Edit and change the Name field to Question.

5. Click Save.

6. Create an Answer field:

= (Click the New Field button

= QObject Type: Question

=  Name: Answer

= Field Type: Long Text

= QOpen to Associations: Yes

7. Click Save and New.

8. Now we will create our Multiple Object field. This is a Document
object field that connects the fields we just created.

=  Object Type: Document

=  Name: Questions
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= Field Type: Multiple Object
=  QObject Type: Question

9. Click Save.

6.1 Question Views

Let’s look at how the Question object can be used and create some
views and layouts to help us see the object fields.

1. Select the Question tab. We need to make some questions so
we can visualize how the objects work together.

2. Click New Question.

i 45E search Terms Reports . Transform Sets . Imaging w ._Domain ._Custodian TM
I

Question Layout - '_::‘ m Save and New Save and Back
Default Category

Question:

Question Field

Go ahead and type a question in the field and save it. We have no
way to answer it yet so our next task will be to fix this layout to
include the Answer field.

3. Click the Layouts Tab and filter on the Question object type.
4. Select the Question Layout.
5. Click Build Layout.

Building Layout: Question Layout

{0:0) Default Category | Add Field||Add Text
(R:1] 0:1 | Read Only: Ho)

(R:1 | 0:20 | Read Only: Na)

Question Layout

6. Click on the Add Field link first and select the Answer field.
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= Category: Default Category
= Field: Answer
= Read Only: No
= Order: 10
7. Click Save
8. The Answer field will then appear on the layout.

9. Next Click Add Associative Object List. This will add the
documents view to the layout.

= Associative Object: Document - Questions
= View: Documents

= Link View: Documents

= Links to Popup: No

= Order: 10

10. Click Save.

L4

Add Associative Object List

Save Save And New

Associative Object: questions ~

m

WiEW: Documents -
Link View: pocuments -
Links Point to Popup:

Order: Zq

Adding Associative Object List
11. Next click on Views tab and filter Object Type to Question.
12. Click Edit for the All Questions view.
The Basic Information form opens on Step 1.
13. Click Next.

14. Double Click on Answer field in the left column to move it to the
right, and then click Done.
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[Dwner: Pubtic -

Fields (step 2 of 4 - =1

Search Indexes \ User st V 1 Grea

Settings
Name: ) questions
Order: 4

Available In Object Tab: ves

Available Fields

Set Fields

Selected Fields

Answer

Artifact 1D

Questions

Security

System Created By
System Created On
System Last Modified By
System Last Modified On

Edit
Question

m

4

All Questions view

While we are in the views tab we could create views for documents
without answers to Questions or documents with Questions. If you have
a senior level reviewer it might be helpful to have a list of questions that
need answering and only those documents get reviewed by a senior

level person.

15. Go to the Layouts Tab and select the Basic document layout.

16. Click Add Associative Object List

= Associative Object: Q & A

=  View: All Questions

= |link View: All Questions

= Links Point to Popup: No

=  QOrder:10

17. Click Save.
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Add Associative Object List

Associative Object:
View:

Link View:

Links Point to Popup:

Order:

Questions -
Documents -

Documents -

19

Update the Basic Layout with Associative Object List

By selecting “Yes” in the “Links Point to Pop-up” drop-down,
Relativity will open a dialog box beside the document view.
By selecting “No”, Relativity will navigate away from the
document and redirect the reviewer to another page.

18. Click on the Documents Tab and open a Document.

19. Select the Basic layout from the coding drop-down. The

Question section is

displayed.

20. Click on the New button and add a Question and answer to this

document.
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Questions - |_L=’_|l

Control Humber: hMEYERS_ﬂ]]y
Question (Questions [ FECA I

= E| 7 ttems1 -3¢0z W 4 b M

Edit  Is this document privilege??

Will paragrah 3 represent the contracts?

O O O K

Edit Whaois Boomer?

0 Selected Item(s) Select Page Size: 10 -

Question section of Questions layout
21. Return to the document list.

22. Click on the Edit View icon and include Q&A and the
Q&A::Answer field.

23. Click Done.

The documents and their corresponding Questions and Answers are
listed. Layouts can be created which show only the Questions without
Answers for higher level reviewers. Questions and Answers can be
added to layouts for reviewers to note comments or answers regarding
certain documents. You can shape your Question object from here.

& E‘f“ [ Edit AMEYERS 0000006 Alen, Paul 5/7/2001 2:59 PM Is this document priviege??
Who is Boomer?
Will paragrah 3 represent the contracts?

Q & A Document View

7. Summary

Now you know the basics of creating Custom Objects and have all the
tools necessary to create more complex objects. Custom Objects can be
used to make more efficient use of data entry and organization. The
possible configurations are endless.
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This documentation (“Documentation”) and the software to which it
relates (“Software”) belongs to kCura Corporation and/or kCura’s third
party software vendors. kCura grants written license agreements which
contain restrictions. All parties accessing the Documentation or
Software must: respect proprietary rights of kCura and third parties;
comply with your organization’s license agreement, including but not
limited to license restrictions on use, copying, modifications, reverse
engineering, and derivative products; and refrain from any misuse or
misappropriation of this Documentation or Software in whole or in part.
The Software and Documentation is protected by the Copyright Act of
1976, as amended, and the Software code is protected by the lllinois
Trade Secrets Act. Violations can involve substantial civil liabilities,
exemplary damages, and criminal penalties, including fines and possible

imprisonment.

©2011. kCura Corporation. All rights reserved. Relativity® and kCura®
are registered trademarks of kCura Corporation.
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